GMPLS UNI for Packet and Optical Integration

With the cloud becoming increasingly central to business operations, packet and optical network services
must evolve to become more efficient and dynamic. Closer integration of packet and optical networks becomes
critical especially in the control plane.
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Understanding GMPLS UNI

Generalized Multiprotocol Label Switching (GMPLS) User Network Interface (UNI) or GMPLS UNI is a
key technology that enables this integration. GMPLS UNI enables packet networks to directly tap into the
optical transport control plane to coordinate its resource requirements with the optical transport network.
Leveraging open standards, GMPLS UNI optimizes network resources and improves network utilization
across packet and optical networks.

Channel Spacing

DWDM grid in the optical spectrum can be divided into multiple channels so that each channel can carry
traffic independently. The number of channels that we receive from the DWDM grid depends on the channel
spacing. For example, the lower the channel spacing, the higher the number of channels, and also conversely.

GMPLS has two types of channel spacing:

* Fixed Grid channel spacing - The channel spacing is fixed to 50 GHz and supports 100 and 200-Gbps
traffic.

* Flexible Grid channel spacing - The channel spacing is 6.25 GHz and supports all data rates.

The neighbor flexi-grid-capable command enables GMPLS UNI flexible grid channel spacing. This
command is executed during the LMP configuration configuration.
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Use Case Overview

GMPLS UNI technology addresses the following customer needs in packet and optical networks:

* Effective usage of the DWDM grid with minimal wastage of spectral bandwidth

* Transmission of mixed bit-rate or mixed modulation data in a grid with different channel widths

To address these needs, you create a tunnel between two NCS 1004 nodes to carry traffic using the GMPLS
UNI technology as shown in the following figure.

Figure 1: GMPLS UNI Reference Model
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UNI-C is the client or packet or router node; for example, NCS 1004 nodes. UNI-N is the network or optical
node; for example, NCS 2000 nodes.

The Link Management Protocol (LMP) link is created to establish connectivity between a NCS 2000 node
and a NCS 1004 node. The tunnel is then created between the trunk interfaces of the source and destination
NCS 1004 nodes to carry traffic. When the tunnel is created between NCS 1004 nodes, a circuit is internally
created between the NCS 2000 nodes. The circuit is created to perform path computation, restoration, and
reversion functions.

The tunnel can be created between the source and destination NCS 1004 nodes without involving NCS 2000
nodes in the middle. However, the restoration and reversion capabilities are provided only by the NCS 2000
nodes using GMPLS UNIL

Prerequisites

Before you create a tunnel using GMPLS UNI, fulfill these prerequisites:

* NCS 1004 node must have both the MPLS and MPLS-TE packages. The package names are ncs1004-mpls
and ncs1004-mpls-te-rsvp.

* NCS 2000 node must have a valid license for ROADM and WSON support.
* The management [P addresses of NCS 1004 and NCS 2000 nodes must be accessible.

* The administrative state of the trunk port of the optics controller on the NCS 1004 node must not be in
the shutdown state.
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Limitations .

Limitations

Configuration Workflow

Perform the following tasks in sequence to create a tunnel using GMPLS UNI:
Configurations on the NCS 2000 node;
1. GMPLS signaled LMP circuit creation.

* #unique 74
2. Retrieve Ifindex from NCS 2000 Node, on page 8

Configurations on the node:
1. Configure LMP on Cisco NCS 1002 Node.
* Configure LMP on Cisco NCS 1004 Node , on page 9

2. Configure RSVP on NCS 1004 Node, on page 10

3. Configure MPLS Tunnel on a NCS 1002 Node.
* Configure MPLS Tunnel on a NCS 1004 Node for Numbered Circuit, on page 11

Configure an LMP link and Alien Wavelength on an NCS 2000 node using CTC

Procedure

Step 1
Step 2
Step 3

Step 4

Establish connectivity and enable advanced opUse this task to set up a static LMP link between a Cisco NCS
2000 node and either an NCS 1004 node. The CTC LMP creation wizard enables you to select source and
destination endpoints, configure optical parameters, and set alien wavelength options. tical parameters and
alien wavelength configurations for signaled numbered circuits between Cisco optical network nodes.

Use this task to set up a static LMP link between a Cisco NCS 2000 node and either an NCS 1002 or NCS
1004 node. The CTC LMP creation wizard enables you to select source and destination endpoints, configure
optical parameters, and set alien wavelength options.

From the View menu, choose Go to Network View.
Click the Provisioning > LMP tabs.
Click Create.

The LMP Creation window appears.

Click Signaled in the Router Not Managed by CTC area.

A wizard appears with the following options:
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Configure an LMP link and Alien Wavelength on an NCS 2000 node using CTC

LMP Origination, LMP Termination, Optical Parameters, and Alien Wavelength
Step 5 In the LMP Origination screen of the wizard, provision these parameters:
* From the Originating Node drop-down list, choose the source node of the LMP.
If the source node is Cisco NCS 1004, the destination node must be MSTP, and the other way round.

* From the Local | nterfaces drop-down list, choose an available interface.
* Choose the Type, Shelf, Slot, and Port for Ingress Port Selection and Egress Port Selection.
* Choose Numbered interface.
* Enter the IP address of the source node in the Interface | P field.

* Set the mode of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion
of the circuit from the restored path to the original path is initiated by the UNI client that is connected
to NCS 1004. If the mode is set to UNI-N, the reversion of the circuit is initiated by the DWDM network
and can either be a manual revert or an auto revert.

* Enter the RSVP signaling interval and RSVP signaling missed values in the respective fields.

» Click Next.

Step 6 In the LMP Termination screen of the wizard, provision these parameters:

* From the Ter minating Node drop-down list, choose the destination node of the LMP; for example,
MSTP node.

* From the Rx Port Selection area, perform the following.
* Choose the card type from the Type drop-down list.
* Choose a shelf from the Shelf drop-down list.
* Choose a source slot from the Slot drop-down list

* Choose a port from the Port drop-down list.

* From the Tx Port Selection area, perform the following.

* Choose the card type from the Type drop-down list.
* Choose a shelf from the Shelf drop-down list.
* Choose a destination slot from the Slot drop-down list.

* Choose a port from the Port drop-down list

« Enter the IP address of the destination node in the | nterface | P field.

* Set the mode of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion
of the circuit from the restored path to the original path is initiated by the UNI client that is connected.
If the mode is set to UNI-N, the reversion of the circuit is initiated by the DWDM network and can be
either a manual revert or an auto revert.

* Enter the remote Ifindex of NCS 1004 node (in decimals) in the Remote If Index field.

* Click Next.
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Step 7 In the Optical Parameters screen of the wizard, provision these parameters:

* Allow Regener ation—When checked, the computed path traverses through the regeneration site only
if the optical validation is not satisfied. You can regenerate a circuit that is created from the UNI interface.
If a transparent path is feasible, the regenerator is not used.

* UNI State—Choose Enable or Disable from the UNI State drop-down list.

The Enable state is used to configure the UNI interface for the circuits to pass through, between the router
and the DWDM node. In the Disable state, the interface is configured but not active, and so the circuit
activation is rejected. When the status is changed from Enable to Disable, all active circuits on the
interface are deleted.

« Description—Enter the description of the UNI interface. The description can be up to 256 characters.
* Label—Enter an alphanumeric string. This label is a unique circuit identifier.

« Validation—Sets the optical validation mode.

* Full—The circuit is created when the circuit validation result is greater than or equal to the acceptance
threshold value.

» None—The circuit is created without considering the acceptance threshold value. The Opt Valid
column in the Circuits tab displays the value as Not Valid.

* Inherited—The restoration circuit inherits the validation and acceptance threshold values from the

primary circuit.

» Acceptancethreshold—Sets the acceptance threshold value for the GMPLS circuit. The circuit is created
if the actual acceptance threshold value is greater than, or equal to, the value set in this field.

« Green—Indicates that the channel failure risk is 0%.
* Yellow—Indicates that the channel failure risk is between 0% and 16%.
* Orange—Indicates that the channel failure risk is between 16% and 50%.

* Red—Indicates that the channel failure risk is greater that 50%.

» Restoration—Check this check box to enable the restoration of the GMPLS circuits on the UNI interface.
» Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.

* Auto Revert—Click this radio button to automatically revert the circuit from the restored path to the
original path after the failure is fixed, WSON alarms are acknowledged, and the soak time expires.

» Manual Revert—Click this radio button to manually revert the circuit from the restored path to the
original path after the failure is fixed, the WSON alarms are acknowledged, and the soak time expires.

 Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on
the restored path waits before moving to the original path after the failure is fixed. The circuit reverts to
the original path after the soak time expires. The soak time must be set only if both the Restoration and
Revert check boxes are checked.

Step 8 Click Next.

Step 9 In the Alien wavelength screen of the wizard, provision these parameters.

* From the Alien Wavelength drop-down list, choose the alien wavelength class.
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* From the Trunk Selection drop-down list, choose 100G, 200G, or 250G.

* From the FEC drop-down list, choose a valid value for forward error correction (FEC) mode. If an invalid
FEC value is chosen, LMP link is created; however, the circuit creation fails.

* Click Finish to create an LMP link.

The LMP link with specified optical parameters and alien wavelength settings is created and listed in CTC,
ready for signaled numbered circuit provisioning.

Configure an LMP link with Alien Wavelength on NCS 2000 using CTC for
signaled unnumbered circuits

Establish connectivity between NCS 2000 and NCS 1002/1004 nodes using a signaled, unnumbered LMP
link with Alien Wavelength support.

Use the LMP creation wizard in Cisco Transport Controller (CTC) to provision link parameters, optical
settings, and Alien Wavelength options for interoperability between managed and unmanaged router nodes.

Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Click the Provisioning > LMP tabs.
Step 3 Click Create.

The LMP Creation window appears.

Step 4 Click Signaled in the Router Not Managed by CTC area.

A wizard appears with options for LM P Origination, LMP Termination, Optical Parameters, and Alien
Wavelength

Step 5 On the LMP Origination screen, provision these parameters:
* From the Originating Node drop-down list, choose the source node of the LMP.
* From the Local I nterfaces drop-down list, choose an available interface.
* Choose the Type, Unit, and Port for Ingress Port Selection and Egress Port Selection.
* Choose Unnumbered interface.
* The IP address of the source node selected appears in the | P field.

* Set the mode of revertive restoration to UNI-N. If the mode is set to UNI-N, the reversion of the circuit
is initiated by the DWDM network and can either be a manual revert or an auto revert.

* Click Next.

Step 6 On the LMP Termination screen of the wizard, provision these parameters:
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« From | nterfaces Configuration:

Enter the NCS 1004 system IP address in the System IP field.
» Enter the IP address of the source node in the Communication Channel field.
* Enter the SNMP Ifindex value of optic trunk in the Remote I f Index field.

» Click Next.

Step 7 In the Optical Parameters screen of the wizard, provision these parameters:

+ Allow Regeneration—When checked, the computed path traverses through the regeneration site only
if the optical validation is not satisfied. You can regenerate a circuit that is created from the UNI interface.
If a transparent path is feasible, the regenerator is not used.

* UNI State—Choose Enable or Disable from the UNI State drop-down list.

The Enable state is used to configure the UNI interface for the circuits to pass through, between the router
and the DWDM node. In the Disable state, the interface is configured but not active, and so the circuit
activation is rejected. When the status is changed from Enable to Disable, all active circuits on the
interface are deleted.

» Description—Enter the description of the UNI interface like Signal Unnumb LM P. The description
can be up to 256 characters.

* Label—Enter an alphanumeric string. This label is a unique circuit identifier.

« Validation—Sets the optical validation mode.

* Full—The circuit is created when the circuit validation result is greater than or equal to the acceptance
threshold value.

* None—The circuit is created without considering the acceptance threshold value. The Opt Valid
column in the Circuits tab displays the value as Not Valid.

* Inherited—The restoration circuit inherits the validation and acceptance threshold values from the

primary circuit.

« Acceptance Threshold—Sets the acceptance threshold value for the GMPLS circuit. The circuit is
created if the actual acceptance threshold value is greater than, or equal to, the value set in this field.

« Green—Indicates that the channel failure risk is 0%.
* Yellow—Indicates that the channel failure risk is between 0% and 16%.
* Orange—Indicates that the channel failure risk is between 16% and 50%.

* Red—Indicates that the channel failure risk is greater than 50%.

» Restoration—Check this check box to enable the restoration of the GMPLS circuits on the UNI interface.
» Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.

* Auto Revert—Click this radio button to automatically revert the circuit from the restored path to the
original path after the failure is fixed, WSON alarms are acknowledged, and the soak time expires.

» Manual Revert—Click this radio button to manually revert the circuit from the restored path to the
original path after the failure is fixed, the WSON alarms are acknowledged, and the soak time expires.
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 Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on
the restored path waits before moving to the original path after the failure is fixed. The circuit reverts to
the original path after the soak time expires. The soak time must be set only if both the Restoration and
Revert check boxes are checked.

Step 8 Click Next.

Step 9 In the Alien wavelength screen of the wizard, provision these parameters.

* From the Alien Wavelength drop-down list, choose the alien wavelength class such as NCS 1004.
* From the Trunk Selection drop-down list, choose 100G, 200G, or 250G.

* From the FEC drop-down list, choose a valid value for forward error correction (FEC) mode. If an invalid
FEC value is chosen, LMP link is created; however, the circuit creation fails.

» Click Finish to create an LMP link.
The newly created signaled LMP unnumbered circuit link appears in the LMP table in CTC.

The LMP link between NCS 2000 and NCS 1002/1004 is established, supporting signaled unnumbered circuits
with full optical and Alien Wavelength configuration.

Retrieve Ifindex from NCS 2000 Node

The Ifindex value of all the LMP ports of NCS 2000 node can be retrieved using CTC or TL1.
Using CTC:

From the Provisioning > L M P tab, retrieve the Ifindex value in decimal format under the Originating
Interface Index column.

This Ifindex value is used in the neighbor interface-id unnumbered command during the LMP configuration
configuration.

Using TL1:
1. Login to the TL1 interface and issue the following command.
2. rtrv-unicfg ::all:1;

This command retrieves the Ifindex of all the LMP ports of NCS 2000 node in hexadecimal format. This must
be converted to decimal format and used in remote Ifindex of NCS 1004 node during the LMP configuration.

TL1 Output

PSLINE-81-1-9-RX:PSLINE-81-1-9-TX,10.77.142.92,3.3.3.4,3.3.3.3,0.0.0.0, VALMODE=NONE, ADMINSTATE=UP,
RESTTYPE=REVERT, USPWROFS=0.0,

DSPWROFS=0.0, ALLOWREGEN=NO, UNICTRLMODE=CLIENT, REVERTMODE=MANUAL, SOAK=00-01-00,
RESTVALMODE=NONE, TERMINTEFDX=0, ORIGINTFIDX=7£000d12, NUMBERED=TRUE, UNIMODE=GMPLS

PSLINE-81-1-10-RX:PSLINE-81-1-10-TX,10.77.142.92,4.4.4.4,4.4.4.3,0.0.0.0, VALMODE=NONE , ADMINSTATE=UP,
RESTTYPE=REVERT, USPWROFS=0.0, DSPWROFS=0.0, ALLOWREGEN=NO, UNICTRLMODE=CLIENT,
REVERTMODE=MANUAL, SOAK=00-01-00, RESTVALMODE=NONE , TERMINTFDX=0,

ORIGINTFIDX=7£000d14, NUMBERED=TRUE, UNIMODE=GMPLS
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The Ifindex of port 81-1-9 is 7f000d 12 (in hexadecimal) and 2130709778 (in decimal). The Ifindex of port
81-1-10 is 7f000d14 (in hexadecimal) and 2130709780 (in decimal).

Configure LMP on Cisco NCS 1004 Node

LMP is a logical link that is created on the trunk optics controller of the source and destination NCS 1004
nodes of the tunnel.

configure

Imp

gmpls optical-uni

controller optics Rack/Sot/Instance/Port
neighbor name

neighbor link-id ipv4 unicast ipv4-address
neighbor flexi-grid-capable

neighbor interface-id unnumbered interface-id
link-id ipv4 unicast ipv4-address

router-id ipv4 unicast ipv4-address

commit

Important Notes

* neighbor link-id ipv4 unicast ipv4-addressis the IP address of the MSTP interface on the NCS 2000
node.

* neighbor flexi-grid-capable enables GMPLS UNI flexible grid channel spacing.

* neighbor interface-id unnumbered interface-id is the optical interface ID of the neighbor. This value
is the Ifindex value of all the LMP ports of NCS 2000 node in decimal format that is manually retrieved
from CTC or TL1. See Retrieve Ifindex from NCS 2000 Node, on page 8 to retrieve the Ifindex.

* link-id ipv4 unicast ipv4-addressis the IP address of the optics controller on the current NCS 1004
node.

* router-id ipv4 unicast ipv4-address s the neighbor router IP address for GMPLS UNI.

Running Configuration
The following is a sample of configuring LMP on the source NCS 1004 node.

show running-config Imp

Mon Jul 1 14:42:46.856 IST
1mp
gmpls optical-uni
controller Optics0/0/0/0
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.1.1
neighbor flexi-grid-capable
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neighbor interface-id unnumbered 2130706976
link-id ipv4 unicast 10.0.1.1

|

controller Optics0/0/0/1
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.3.3
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130707232
link-id ipv4 unicast 10.0.3.3

|

controller Optics0/1/0/0
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.4.4
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706964
link-id ipv4 unicast 10.0.4.4

|

controller Optics0/1/0/1
neighbor ncslk
neighbor link-id ipv4 unicast 10.1.5.5
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706966
link-id ipv4 unicast 10.0.5.5

|

neighbor ncslk
ipcc routed
router-id ipv4 unicast 10.127.60.48

|

router-id ipv4 unicast 10.105.57.101

|

|

The following sample shows the brief summary of the tunnel status and configuration.

show mplstraffic-eng tunnels optical-uni brief

Wed Sep 22 17:08:13.132 IST

TUNNEL NAME DESTINATION STATUS STATE
GMPLS-UNI-Optics0/3/0/1 10.24.1.1 up up
GMPLS-UNI-Optics0/0/0/1 10.34.1.1 up up

Displayed 2 (of 2) heads, 0 (of 0) midpoints, 0 (of 0) tails
Displayed 2 up, 0 down, O recovering, 0 recovered heads

Configure RSVP on NCS 1004 Node

Resource Reservation Protocol (RSVP) with an appropriate timeout must be configured on the source and
destination NCS 1004 nodes of the tunnel.

configure

rsvp

controller optics Rack/Sot/Instance/Port
signalling refresh out-of-band interval interval
signalling refresh out-of-band missed mis-count
commit

The following is a sample of configuring RSVP on the source NCS 1004 node.
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RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO

Configure MPLS Tunnel on a NCS 1004 Node for Numbered Circuit .

:ios#configure

:ios (config) #rsvp

:ios (config-rsvp) #controller optics 0/0/0/6
:ios
:ios
:ios (config-rsvp-cntl) #commit

config-rsvp-cntl) #signalling refresh out-of-band interval 3600
config-rsvp-cntl) #signalling refresh out-of-band missed 24

(
(
(
(

Configure MPLS Tunnel on a NCS 1004 Node for Numbered Circuit

Ensure that the administrative state of the trunk port of the optics controller on the NCS 1004 node is not in

shutdown state.

configure

mplstraffic-eng

gmpls optical-uni
controller optics Rack/Sot/Instance/Port

tunnel-properties

tunnel-id id

destination ipv4 unicast ipv4-address

path-option 10 no-ero lockdown

commit

Important Notes

« destination
1004 node.

ipv4 unicast ipv4-addressis the IP address of the optics controller on the destination NCS

* Explicit Route Object (ERO) - Includes one or more routes to use from a list of specified nodes for a

tunnel.

* Exclude Route Object (XRO) - Excludes one or more routes to use from a list of specified nodes for a

tunnel.

Running Configuration

The following is

RP/0/RP0O/CPUO
RP/0/RP0/CPUO
RP/0/RP0O/CPUO
RP/0/RP0/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO
RP/0/RP0/CPUO
RP/0/RP0O/CPUO
RP/0/RP0O/CPUO

The following is

RP/0/RP0O/CPUO:

a sample of configuring the MPLS tunnel on the source NCS 1004 node.

:ios#configure

:ios(config) #mpls traffic-eng
:ios (config-mpls-te) #gmpls optical-uni

:ios (config-te-gmpls-uni) #controller optics 0/0/0/6
:ios (config-te-gmpls-cntl) #tunnel-properties

tios(
(
(
(

config-te-gmpls-tun) #tunnel-id 100

:ios (config-te-gmpls-tun) #destination ipv4 unicast 10.20.20.20
:ios (config-te-gmpls-tun) #path-option 10 no-ero lockdown
:ios (config-te-gmpls-tun) #commit

a sample of configuring the MPLS tunnel on the destination NCS 1004 node.

ios#configure
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RP/0/RP0/CPUO:i0s (config) #mpls traffic-eng

RP/0/RP0/CPUO:i0s

GMPLS UNI for Packet and Optical Integration |

config-te-gmpls-uni) #controller optics 0/0/0/6

(

RP/0/RP0O/CPUO:ios (config-mpls-te) #gmpls optical-uni
(
(

RP/0/RP0O/CPUO:i0s (config-te-gmpls-uni) #commit

Verification

Use the show commands in the following table to verify the GMPLS UNI tunnel, RSVP, and LMP

configuration.

Table 1: Show Commands

Show Commands

Description

show mplstraffic-eng link-management optical-uni
controller optics

Displays detailed GMPLS information of a specific
optics controller.

show mplstraffic-eng link-management optical-uni

Displays detailed GMPLS information of all the optics
controllers.

show mplstraffic-eng tunnels

Displays information about tunnels.

show mplstraffic-eng link-management optical-uni
tabular

Displays detailed GMPLS information of all the optics
controllers in tabular format.

show mplstraffic-eng tunnelstabular

Displays information about all the tunnels in tabular
format.

show Imp gmpls optical-uni

Verifies LMP configuration and state.

show rsvp neighbors

Displays information about RSVP neighbors.

Sample Outputs

show mplstraffic-eng link-management optical-uni controller optics 0/0/0/13

Displays detailed GMPLS information of a specific optics controller.

Mon Jul 1 20:05:27.209 IST
Optical interface: Optics0/0/0/0
Overview:
IM state: Up

Child interface: IM state Unknown

OLM/LMP state: Up

Optical tunnel state: up
Connection:

Tunnel role: Tail

Tunnel-id: 15, LSP-id 3,

Tunnel source: 10.105.57.100,
Optical router-ids: Local: 10.105.57.101,
Label source: UNI-N
Upstream label:

Optical label:

Grid : DWDM
Channel spacing 6.25 GHz
Identifier : 0
Channel Number =277
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Verification .

Downstream label:
Optical label:

Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : =277

SRLG discovery: Disabled
SRLG announcement: None
Switching Type: lsc
MTU: 9212
Admission Control:
Upstream: Admitted (LSP ID: 3)
Downstream: Admitted (LSP ID: 3)
OLM/LMP adjacency information:
Adjacency status: Up
Local:
node ID: 10.105.57.101
link interface ID: 10
link ID: 10.11.1.1
Neighbor:
node ID: 10.127.60.48 (VEGA2K-Site-3_48)
link interface ID: 2130706976
link ID: 10.1.1.1
IPCC: Routed to 10.127.60.48
Optical capabilities:
Controller type: DWDM
Channel spacing: 6.25 GHz
Default channel: 0
784 supported channels:
-303, -302, -301, -300, =299, -298, -297, -296
-295, -294, -293, -292, -291, -290, -289, -288
-287, -286, -285, -284, -283, -282, -281, -280
-279, -278, =277, =276, =275, =274, =273, =272
-271, =270, -269, -268, -267, -266, -265, -264
-263, -262, -261, -260, -259, -258, -257, -256
-255, -254, -253, -252, -251, -250, -249, -248
-247, -246, -245, -244, -243, =242, -241, =240
-239, -238, -237, -236, -235, -234, -233, -232
-231, -230, =229, =-228, =227, =226, =225, =224
-223, -222, =221, =220, =219, -218, -217, =216
-215, -214, -213, -212, =-211, =-210, -209, -208
-207, -206, -205, -204, -203, -202, -201, -200
-199, -198, -197, -196, -195, -194, -193, -192
-191, -190, -189, -188, -187, -186, -185, -184
-183, -182, -181, -180, -179, -178, -177, -176
-175, -174, -173, -172, -171, -170, -169, -168
-167, -166, -165, -1l64, -163, -162, -161, -160
-159, -158, -157, -156, -155, -154, -153, -152
-151, -150, -149, -148, -147, -146, -145, -144
-143, -142, -141, -140, -139, -138, -137, -136
-135, -134, -133, -132, -131, -130, -129, -128
-127, -126, -125, -124, -123, -122, -121, -120
-119, -118, -117, -116, -115, -114, -113, -112
-111, -110, -109, -108, -107, -106, -105, -104
-103, -102, -101, -100, =99, -98, -97, -96
-95, -94, -93, -92, -91, -90, -89, -88
-87, -86, -85, -84, -83, -82, -81, -80
-79, -78, -77, -76, -75, -74, -73, =72
-71, =70, -69, -68, -67, -66, -65, -64
-63, -62, -61, -60, -59, -58, -57, -56
-55, -54, -53, -52, -51, -50, -49, -48
-47, -46, -45, -44, -43, -42, -41, -40
-39, -38, -37, -36, -35, -34, -33, -32
-31, -30, -29, -28, -27, -26, =25, -24
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-23, -22, -21, -20, -19,
-15, -14, -13, -12, -11,
-7, -6, -5, -4, -3, -2,
1, 2, 3, 4, 5, 6, 7, 8

-18,
-10,

_1’

9, 10, 11, 12, 13, 14, 15,

17, 18, 19, 20, 21, 22,
25, 26, 27, 28, 29, 30,
33, 34, 35, 36, 37, 38,
41, 42, 43, 44, 45, 46,
49, 50, 51, 52, 53, 54,
57, 58, 59, 60, 61, 62,
65, 66, 67, 68, 69, 70,
73, 74, 75, 76, 17, 78,
81, 82, 83, 84, 85, 86,
89, 90, 91, 92, 93, 94,

23,
31,
39,
47,
55,
63,
71,
79,
87,
95,

97, 98, 99, 100, 101, 102,
110,
118,
126,
134,
142,
150,
158,
166,
174,
182,
190,
198,
206,
214,
222,
230,
238,
246,
254,
262,
270,
278,
286,
294,
302,
310,
318,
326,
334,
342,
350,
358,
366,
374,
382,
390,
398,
406,
414,
422,
430,
438,
446,
454,
162,
470,
478,

105, 106, 107, 108, 109,
113, 114, 115, 116, 117,
121, 122, 123, 124, 125,
129, 130, 131, 132, 133,
137, 138, 139, 140, 141,
145, 146, 147, 148, 149,
153, 154, 155, 156, 157,
161, 162, 163, 164, 165,
169, 170, 171, 172, 173,
177, 178, 179, 180, 181,
185, 186, 187, 188, 189,
193, 194, 195, 196, 197,
201, 202, 203, 204, 205,
209, 210, 211, 212, 213,
217, 218, 219, 220, 221,
225, 226, 227, 228, 229,
233, 234, 235, 236, 237,
241, 242, 243, 244, 245,
249, 250, 251, 252, 253,
257, 258, 259, 260, 261,
265, 266, 267, 268, 269,
273, 274, 275, 276, 277,
281, 282, 283, 284, 285,
289, 290, 291, 292, 293,
297, 298, 299, 300, 301,
305, 306, 307, 308, 309,
313, 314, 315, 316, 317,
321, 322, 323, 324, 325,
329, 330, 331, 332, 333,
337, 338, 339, 340, 341,
345, 346, 347, 348, 349,
353, 354, 355, 356, 357,
361, 362, 363, 364, 365,
369, 370, 371, 372, 373,
377, 378, 379, 380, 381,
385, 386, 387, 388, 389,
393, 394, 395, 396, 397,
401, 402, 403, 404, 405,
409, 410, 411, 412, 413,
417, 418, 419, 420, 421,
425, 426, 427, 428, 429,
433, 434, 435, 436, 437,
441, 442, 443, 444, 445,
449, 450, 451, 452, 453,
457, 458, 459, 460, 461,
465, 466, 467, 468, 469,
473, 474, 475, 476, 477,
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0

16
24
32
40
48
56
64
72
80
88
96

103

, 104
111,
119,
127,
135,
143,
151,
159,
167,
175,
183,
191,
199,
207,
215,
223,
231,
239,
247,
255,
263,
271,
279,
287,
295,
303,
311,
319,
327,
335,
343,
351,
359,
367,
375,
383,
391,
399,
407,
415,
423,
431,
439,
447,
455,
463,
471,
479,

112
120
128
136
144
152
160
168
176
184
192
200
208
216
224
232
240
248
256
264
272
280
288
296
304
312
320
328
336
344
352
360
368
376
384
392
400
408
416
424
432
440
448
456
464
472
480
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Verification .

Controller SRLGs
None

show mplstraffic-eng link-management optical-uni

Displays detailed GMPLS information of all the optics controllers. MPLS tunnels are not created when the
optics controller is in the shutdown state. The state is displayed as Admin down. Enter the no shutdown
command under the optics controller to initiate the tunnel creation.

Mon Jul 1 20:00:42.108 IST

System Information:
Optical Links Count: 1 (Maximum Links Supported 100)

Optical interface: Optics0/0/0/0

Overview:
IM state: Up
Child interface: : IM state Unknown

OLM/LMP state: Up
Optical tunnel state: up
Connection:
Tunnel role: Tail
Tunnel-id: 15, LSP-id 3, Extended tunnel-id 10.105.57.100
Tunnel source: 10.105.57.100, destination: 10.11.1.1
Optical router-ids: Local: 10.105.57.101, Remote: 10.127.60.48
Label source: UNI-N
Upstream label:
Optical label:

Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : =277

Downstream label:
Optical label:

Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : =277

SRLG discovery: Disabled
SRLG announcement: None
Switching Type: 1lsc
MTU: 9212
Admission Control:
Upstream: Admitted (LSP ID: 3)
Downstream: Admitted (LSP ID: 3)
OLM/LMP adjacency information:
Adjacency status: Up
Local:
node ID: 10.105.57.101
link interface ID: 10
link ID: 10.11.1.1
Neighbor:
node ID: 10.127.60.48 (VEGA2K-Site-3 48)
link interface ID: 2130706976
link ID: 10.1.1.1
IPCC: Routed to 10.127.60.48
Optical capabilities:
Controller type: DWDM
Channel spacing: 6.25 GHz
Default channel: 0
784 supported channels:
-303, -302, -301, -300, -299, -298, -297, -296
-295, -294, -293, -292, -291, -290, -289, -288

GMPLS UNI for Packet and Optical Integration [JJjj



GMPLS UNI for Packet and Optical Integration |
. Verification

-287, -286, -285, -284, -283, -282, -281, -280
-279, -278, =277, =276, =275, -274, =273, =272
-271, =270, -269, -268, -267, -266, -265, -264
-263, -262, -261, -260, -259, -258, -257, -256
-255, -254, -253, =252, -251, -250, -249, -248
-247, -246, -245, -244, =243, =242, =241, =240
-239, -238, -237, -236, -235, -234, -233, -232
-231, -230, -229, -228, =227, -226, -225, -224
-223, -222, -221, -220, -219, -218, -217, -216
-215, -214, -213, -212, -211, -210, -209, -208
-207, -206, -205, -204, -203, -202, =201, =200
-199, -198, -197, -196, -195, -194, -193, -192
-191, -190, -189, -188, -187, -186, -185, -184
-183, -182, -181, -180, -179, -178, -177, -176
-175, -174, -173, -172, -171, -170, -169, -168
-167, -166, -165, -164, -163, -162, -161, -160
-159, -158, -157, -156, -155, -154, -153, -152
-151, -150, -149, -148, -147, -146, -145, -144
-143, -142, -141, -140, -139, -138, -137, -136
-135, -134, -133, -132, -131, -130, -129, -128
-127, -126, -125, -124, -123, -122, -121, -120
-119, -118, -117, -116, -115, -114, -113, -112
-111, -110, -109, -108, -107, -106, -105, -104
-103, -102, -101, -100, -99, -98, -97, -96
-95, -94, -93, -92, -91, -90, -89, -88

-87, -86, -85, -84, -83, -82, -81, -80

-79, -78, =77, =76, =75, -74, =73, =72

-71, -70, -69, -68, -67, —-66, -65, —-64

-63, -62, -61, -60, -59, -58, -57, -56

-55, -54, -53, -52, -51, -50, -49, -48

-47, -46, -45, -44, -43, -42, -41, -40

-39, -38, -37, -36, -35, -34, -33, -32

-31, -30, -29, -28, -27, -26, -25, =24

-23, -22, -21, -20, -19, -18, -17, -16

-15, -14, -13, -12, -11, -10, -9, -8

-7, -6, -5, -4, -3, -2, -1, 0

1, 2, 3, 4, 5, 6, 7, 8

9, 10, 11, 12, 13, 14, 15, 16

17, 18, 19, 20, 21, 22, 23, 24

25, 26, 27, 28, 29, 30, 31, 32

33, 34, 35, 36, 37, 38, 39, 40

41, 42, 43, 44, 45, 46, 47, 48

49, 50, 51, 52, 53, 54, 55, 56

57, 58, 59, 60, 61, 62, 63, 64

65, 66, 67, 68, 69, 70, 71, 72

73, 74, 75, 76, 77, 78, 79, 80

81, 82, 83, 84, 85, 86, 87, 88

89, 90, 91, 92, 93, 94, 95, 96

97, 98, 99, 100, 101, 102, 103, 104

105, 106, 107, 108, 109, 110, 111, 112

113, 114, 115, 116, 117, 118, 119, 120

121, 122, 123, 124, 125, 126, 127, 128

129, 130, 131, 132, 133, 134, 135, 136

137, 138, 139, 140, 141, 142, 143, 144

145, 146, 147, 148, 149, 150, 151, 152

153, 154, 155, 156, 157, 158, 159, 160

161, 162, 163, 164, 165, 166, 167, 168

169, 170, 171, 172, 173, 174, 175, 176

177, 178, 179, 180, 181, 182, 183, 184

185, 186, 187, 188, 189, 190, 191, 192

193, 194, 195, 196, 197, 198, 199, 200

201, 202, 203, 204, 205, 206, 207, 208

209, 210, 211, 212, 213, 214, 215, 216

217, 218, 219, 220, 221, 222, 223, 224
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225, 226, 227, 228, 229, 230, 231, 232
233, 234, 235, 236, 237, 238, 239, 240
241, 242, 243, 244, 245, 246, 247, 248
249, 250, 251, 252, 253, 254, 255, 256
257, 258, 259, 260, 261, 262, 263, 264
265, 266, 267, 268, 269, 270, 271, 272
273, 274, 275, 276, 277, 278, 279, 280
281, 282, 283, 284, 285, 286, 287, 288
289, 290, 291, 292, 293, 294, 295, 296
297, 298, 299, 300, 301, 302, 303, 304
305, 306, 307, 308, 309, 310, 311, 312
313, 314, 315, 316, 317, 318, 319, 320
321, 322, 323, 324, 325, 326, 327, 328
329, 330, 331, 332, 333, 334, 335, 336
337, 338, 339, 340, 341, 342, 343, 344
345, 346, 347, 348, 349, 350, 351, 352
353, 354, 355, 356, 357, 358, 359, 360
361, 362, 363, 364, 365, 366, 367, 368
369, 370, 371, 372, 373, 374, 375, 376
377, 378, 379, 380, 381, 382, 383, 384
385, 386, 387, 388, 389, 390, 391, 392
393, 394, 395, 396, 397, 398, 399, 400
401, 402, 403, 404, 405, 406, 407, 408
409, 410, 411, 412, 413, 414, 415, 416
417, 418, 419, 420, 421, 422, 423, 424
425, 426, 427, 428, 429, 430, 431, 432
433, 434, 435, 436, 437, 438, 439, 440
441, 442, 443, 444, 445, 446, 447, 448
449, 450, 451, 452, 453, 454, 455, 456
457, 458, 459, 460, 461, 462, 463, 464
465, 466, 467, 468, 469, 470, 471, 472
473, 474, 475, 476, 477, 478, 479, 480
Controller SRLGs
None

show mplstraffic-eng link-management optical-uni tabular

Displays detailed GMPLS information of all the optics controllers in tabular format.

Mon Jul 1 15:10:50.472 IST

System Information:
Optical Links Count: 4 (Maximum Links Supported 100)

State LMP GMPLS tunnel
Interface Admin Oper adjacency role tun-id state
Op0/0/0/0 up up up Tail 15 up
Op0/0/0/1 up up up Tail 16 up
Op0/1/0/0 up up up Tail 17 up
Op0/1/0/1 up up up Tail 18 up

show mplstraffic-eng tunnels

Displays information about tunnels.

Mon Jul 1 15:03:58.490 IST

LSP Tunnel 10.105.57.100 15 [5] is signalled, Signaling State: up
Tunnel Name: ckt0/0/0/0 Tunnel Role: Tail
Upstream label:
Optical label:
Grid : DWDM
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Channel spacing 6.25 GHz

Identifier 0

Channel Number =277
Downstream label:

Optical label:

Grid DWDM

Channel spacing 6.25 GHz

Identifier 0

Channel Number =277

Signalling Info:
Src 10.105.57.100 Dst 10.11.1.1, Tun ID 15,
Router-IDs: upstream 10.127.60.48

local 10.105.57.101

7 7

collected

Tun Ins

Priority:
SRLGs: not
Path Info:
Incoming
Incoming:
Explicit
No ERO

Address: 10.1.1.1

Route:

Route Exclusions:

No XRO
Record Route: Disabled
Tspec: avg rate=4294967033 kbits, burst=1000 byte

Session Attributes:
Resv Info: None
Record Route: Disabled
Fspec: avg rate=4294967033 kbits, burst=1000 byte
Displayed 0 (of 0) heads, 0 (of 0) midpoints, 1 (of 1)
Displayed 0 up, 0 down, 0 recovering, 0 recovered heads

Local Prot: Not Set, Node Pro

show rsvp neighbors
Displays information about RSVP neighbors.
Mon Jul 1 14:58:48.888 IST

Global Neighbor: 10.127.60.48
Interface Neighbor Interface

10.127.60.48 MgmtEthO/RP0O/CPUO/0
show Imp gmpls optical-uni

Verifies LMP configuration and state.

Mon Jul 1 14:55:35.492 IST

GMPLS Optical-UNI LMP Router ID: 10.105.57.101

LMP Neighbor

Name: ncslk, IP: 10.127.60.48, Owner: GMPLS Optical-UNI
LMP: Disabled

IPCC ID: 1, State Up

LMP UDP port: 701

Known via Configuration

Type Routed

10.127.60.48
10.105.57.101

Destination IP
Source IP

Interface I/F |  Lcl Interface ID | Lcl Link
______________________ o
Optics0/1/0/1 7 10.0
Optics0/1/0/0 6 10.0
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t 5, Ext ID 10.105.57.100

s, peak rate=4294967033 kbits
t: Not Set, BW Prot: Not Set

s, peak rate=4294967033 kbits
tails

ID | Interface LMP state
e
5.5 Up
4.4 Up
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General Troubleshooting .

Optics0/0/0/1 11 10.0.3.3 Up
Optics0/0/0/0 10 10.11.1.1 Up

General Troubleshooting

Collect and analyze the output of the following commands for any software issues.

« show tech-support mplstraffic-eng file filename

« show tech-support mplsrsvp file filename

« show Imp clients

« show rsvp neighbors

« show mplstraffic-eng link-management optical-uni controller optics Rack/Sot/Instance/Port

+ show mplstraffic-eng tunnels tunnel-id

Problem Solution

When NCS 2000 node cannot route the DWDM As a superuser, collect and analyze the diagnostic
wavelength to the destination, it displays a generic | information by entering the following address at the
error message as No Route to destination. browser.

http://ip-address-of-head-node/diagnostics/wson

You May Be Also Interested In

* GMPLS UNI commands: Cisco IOS XR MPLS Command Reference.

* GMPLS Restoration and Reversion
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https://www.cisco.com/c/en/us/td/docs/routers/crs/software/mpls/command/reference/b-mpls-cr-crs/gmpls-uni-commands.html
https://www.cisco.com/c/en/us/td/docs/optical/r11/ncs/network-config/guide/b_ncs_network_configuration-R11/b_ncs_network_configuration_chapter_0100.html#ID2641
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